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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 10.0 to support BT
Wholesale Hosted SIP Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the public switched telephone network (PSTN) with various Avaya
endpoints.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

BT Wholesale is a member of the Avaya DevConnect Service Provider Program. Information
in these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunking service between BT Wholesale and an Avaya SIP-enabled enterprise solution.

In the configuration used during the testing, the Avaya SIP-enabled enterprise solution consists
of Avaya IP Office 500 V2 Release 10.0 (hereafter referred to as IP Office) and various Avaya
endpoints, listed in Section 4.

The BT Wholesale Hosted SIP Trunking Service referenced within these Application Notes is
designed for business customers. Customers using this service with the Avaya IP Office solution
are able to place and receive PSTN calls via a broadband wide area network (WAN) connection
using the SIP protocol. This converged network solution is an alternative to traditional PSTN
trunks such as analog and/or ISDN-PRI trunks. This approach generally results in lower cost for
the enterprise.

The terms “service provider”, “BT” or “BT Wholesale” will be used interchangeably throughout
these Application Notes.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to BT Wholesale’s network
via the public Internet, as depicted in Figure 1, and exercise the features and functionalities listed
in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunk interoperability the following features and functionalities were exercised
during the interoperability compliance test:
e Public DNS “SRV” record queries to establish the SIP trunk connection.
« SIP Trunk Registration (Dynamic Authentication).
e Response to SIP OPTIONS queries.
e Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, digital, and
analog telephones at the enterprise. All incoming calls from the PSTN were routed to the
enterprise across the SIP Trunk from the service provider networks.
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Outgoing PSTN calls from Avaya endpoints including SIP, H.323, digital and analog
telephones at the enterprise. All outgoing calls to the PSTN were routed from the
enterprise across the SIP trunk to the service provider network.

Incoming and outgoing PSTN calls to/from Avaya Communicator for Windows
Softphone.

Incoming and outgoing PSTN calls to/from Avaya Communicator for Web softphone.
Local calls.

Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with coverage to
voicemail off).

Proper response to busy endpoints.

Proper response/error treatment when dialing invalid numbers.

Proper codec negotiation and two way speech-path. Testing was performed with codecs:
G.711A, G.711U, G.722 64K and G.729(a), BT Wholesale’s preferred codec order.
Proper response to no matching codecs.

Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail
messages, etc.).

Calling number blocking (Privacy).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

T.38 and G711 pass-through fax

Items not supported or not tested included the following:

REFER message for call redirection was not tested for reasons noted under Section 2.2.
T.38 fax was not tested for reasons noted under Section 2.2

Inbound and Outbound toll-free calls were not tested.

0, 0+10 digits, 411 Directory Assistance and 911 Emergency calls were not tested.
Outbound international calls were not tested.
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2.2. Test Results

Interoperability testing of BT Wholesale Hosted SIP Services was completed with successful
results for all test cases with the exception of the observations/limitations described below.

Call transfers using the SIP REFER method: Calls that were transferred to the
network using the SIP REFER method did not work properly. Due to this reasons, the
compliance testing was done with SIP REFER disabled in the Avaya IP Office. With the
SIP REFER method disabled, call transfers worked properly, with the caveat that IP
Office SIP Trunk resources were not released from the call path until the call was
released by the IP Office end-users. Two trunks circuits remained seized for the duration
of the call.

Outbound Calling Party Number (CPN) Block: BT Wholesale did not allow outbound
calls with privacy enabled. When an IP Office user activated “Withhold Number” to
enable user privacy on an outbound call, IP Office sent “anonymous” in the “From”
header and the “Privacy: id” header, while the caller information was still sent in the “P-
Asserted-Identity” header. BT Wholesale responded with a “404 Not Found” message
and the call was rejected. The work around is to turn-on “Call Line ID Blocking” on the
DDI/DID number assigned to the end-user’s telephone via the BT Portal and not to
activate “Withhold Number” on the Avaya telephone to enable user privacy on outbound
calls.

Fax support: Incoming fax calls (calls from BT to IP office) using the T.38 protocol
failed during the test, outgoing T.38 fax calls (calls from IP Office to BT) worked
properly. G.711 pass-through fax was also tested, G.711 pass-through fax calls were
successful in both directions (incoming and outgoing). The issue with incoming T.38 fax
calls was reported to BT. Avaya recommends G.711 pass-through fax is for this solution.

2.3. Support

For support on BT Wholesale systems visit the corporate Web page at:
https://www.btwholesale.com/pages/static/home.htm

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)

provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the BT Wholesale Hosted SIP trunking service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500 V2.
e Avaya Voicemail Pro for IP Office.

Avaya IP Office Application Server.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 1100 Series SIP IP Deskphones.

Avaya Communicator for Windows Softphone.

Avaya Communicator for Web.

Avaya 1408 Digital Telephones.

The enterprise site contains the Avaya IP Office 500 V2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of Avaya IP Office is connected to the enterprise LAN (private network)
while the LAN2 port is connected to the public network. Endpoints include Avaya 96x1 Series
IP Deskphones (with H.323 firmware), Avaya 1100 IP Deskphones (with SIP firmware), digital,
and analog Deskphones, PC running Avaya Communicator for Windows and Avaya
Communicator for Web Softphones. The site also has a Windows PC running Avaya IP Office
Manager to configure and administer the Avaya IP Office system, and Avaya Voicemail Pro
providing voice messaging service to the Avaya IP Office users. Mobile Twinning is configured
for some of the Avaya IP Office users so that calls to these user’s extensions will also ring and
can be answered at the configured mobile phones. The Avaya IP Office Application Server is
required for Avaya Communicator for Web softphones.

The transport protocol between IP Office and BT Wholesale, across the public Internet, is SIP
over UDP. The transport protocol between Avaya endpoints and IP Office, inside the enterprise
private IP network (LAN), is SIP over TLS.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to BT Wholesale. The short code 9 was stripped off by Avaya IP Office but
the remaining N digits were sent unaltered to the network. Refer to Section 5.5.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the Avaya IP Office system, such as a session
border controller or data firewall. A complete discussion of the configuration of these devices is
beyond the scope of these Application Notes. However, it should be noted that all SIP and RTP
traffic between the service provider and the Avaya IP Office system must be allowed to pass
through these devices.
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Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products only (private network side). Readers should consult the appropriate Avaya product
documentation for further information regarding security and encryption capabilities supported
by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

For the testing associated with this Application Note, the interface between the Avaya system
and the BT Wholesale network did not include the use of any specific encryption features, UDP
Transport for signaling and RTP for media was used between the Avaya system and the BT
Wholesale network across the SIP Trunk. TLS transport for signaling and SRTP for media was
used inside of the enterprise (private network side, in between Avaya components inside of the
enterprise).
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For confidentiality and privacy purposes, public IP addresses and routable DDI/DID numbers
used during the compliance testing have been masked.
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Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software | Release/Version
Avaya

Avaya IP Office 500v2 10.0.0.3.0 Build 5
Avaya IP Office DIG DCPx16 V2 10.0.0.3.0 Build 5
Avaya IP Office Manager 10.0.0.3.0 Build 5
Avaya Voicemail Pro 10.0.0.3.0 Build 5
Avaya IP Office Application Server 10.0.0.2.0 Built 10

- Avaya WebRTC Gateway 10.0.0.3.0 Built 7

- Avaya one-X Portal for IP Office 10.0.0.2.0 Built 13
Avaya 96x1 Series IP Deskphones (H.323) Version 6.6401
Avaya 1140E IP Deskphones (SIP) SIP1140e Ver. 04.04.23.00
Avaya Communicator for Windows 2.1.3.0-237
Avaya Communicator for Web 1.0.16.1718
Avaya Digital Deskphones 1408 R46
Lucent Analog Phone --

BT Wholesale Hosted SIP Trunking Service

ASbc Genband Q209.1.13
BroadWorks R20 SP1

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500 V2 and also when deployed with all configurations of IP Office Server Edition.
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5. Configure Avaya IP Office

This section describes the IP Office configuration required to interwork with BT Wholesale
Hosted SIP Trunking service. IP Office is configured through Avaya IP Office Manager (IP
Office Manager) which is a PC application. On the PC, select Start = Programs -> IP Office
-> Manager to launch IP Office Manager. Navigate to File > Open Configuration, select the
proper IP Office from the pop-up window, and log in with the appropriate credentials. A
management window will appear as shown in the next sections. The appearance of IP Office
Manager can be customized using the View menu (not shown). In the screenshots presented in
this section, the View menu was configured to show the Navigation Pane on the left side and the
Details Pane on the right side. These panes will be referenced throughout these Application
Notes.

These Application Notes assume the basic installation and configuration of IP Office have
already been completed and are not discussed here. For further information on IP Office, please
consult Error! Reference source not found. in Section 9.

5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License, then
from the license tab, locate SIP Trunk Channels. Confirm that there is a valid license with
sufficient “Instances” (trunk channels) in the Details pane.

| IP Offices \
=R BOOTP (5) License | Remote Server
#-4% Operator (3)
=[5 1P500V2 Main License Mode License Normal
- %59 System (1) . .
ST Lne 25) Licensed Version 100
<= Contral Unit (4) PLDS Host 1D
- Extension (48) )
-§ User (50) PLDS File Status  Valid
5% Group (1)
= g 2““ C?Ud)e 69) Feature Key Instances Status Expiration Date Source  * Add..
@B Service
5o RAS (1) Essential Edition Additional Voice.. N/A 4 Valid Never PLDS Moc
) Incoming Call Route (3) VMPro TTS (Generic) MN/A 40 Valid Never PLDS Noc Remove
& WAN Port (0) Teleworker N/A 384 Valid Never PLDS Moc
o= Directory (0) Mobile Warker N/A 384 Valid Never PLDS Nac
+® ;‘r’:z:”';fr":ﬁgm Office Warker N/A 384 Valid Never PLDS Nac
= Jifll 1P Route (7) Avaya Softphone Licence N/A 100 Valid Never PLDS Nec
#m Account Code (0) VMPra TTS (Scansoft) N/A 40 Valid Never PLDS MNoc
R | License (90)] VMPro TTS Professional N/A 40 Valid Never PLDS Noc
& Tunnel (0} 1PSec Tunneliing N/A 1 Valid Never PLDS Noc
iy i( z;i’g'lgh" @ Power User N/A 384 Valid Never PLDS Noc
) ¥ 50: Main Avaya IP endpoints N/A 384 Valid Never PLDS MNoc
‘¢ 51: Qutbound Fax 1PS00 Voice Networking Channels  N/A 22 Valid Never PLDS Moc
i@ Location (0) [SIP Trunk Channels N/A 128 Valid Never PLDS Noc
% Authorization Code (0) 1P500 Universal PRI (Additional cha... N/A 100 Valid Never PLDS Moc
CTILink Pro N/A 1 Valid Never PLDS Noc
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To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500 V2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An Avaya IP Office hardware configuration
with a VCM component is necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The

following screen shows the details of the IP 500 V2.

x

IP Offices = IP 500 V2
- R BOOTP (5) Unit
+-¢# Operator (3)
=45 IP500V2 Main Device Numnber 1
fr---"-:- Systern (1)
+-F7 Line (25) Unit Type IP 500 V2
o _C_D”"J Version 10.0.0.3.0 build 5
;EEEE‘E;RID v Senal Mumber
i iy b DIG DCPad6 V2 .
: 10.64.70.50
+& Extension (48) Unit IP Address
+= User (50) Interconnect Number 0
+ﬂ Group (1)
+“ Short Cede (69) Module Number Control Unit
B Service (0)
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5.2. System

Configure the necessary system settings. In an Avaya IP Office the LAN2 tab settings
correspond to the Avaya IP Office WAN port (public network side) and the LAN1 tab settings
correspond to the LAN port (private network side).

5.2.1. System — LAN2 Tab

In the sample configuration, the Avaya IP Office WAN port was used to connect to BT
Wholesale. The LAN2 settings correspond to the WAN port on the Avaya IP Office 500 V2. To
access the LAN2 settings, first navigate to System - <Name>, where <Name> is the system
name assigned to the Avaya IP Office. In this compliance test, the system name is IP500V2
Main. Next, navigate to the LAN2 - LAN Settings tab in the Details Pane, configure the

following parameters:

e Setthe IP Address field to the public IP address assigned to the Avaya IP Office

WAN port.

e Setthe IP Mask field to the mask used with the public IP address. All other
parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices

7

IP500V2 Main®

- % BOOTP (5)

+' Operator (3]

= “29 IP500V2 Main

_s-.: S}rStEI‘TI (]_]
ey [PS00V2 Main
+-T4 Line (23]

+ = Control Unit (4)
it

+

-4 Extension (48)
d-§  User (50)
+;a Group (1)
+-@% Short Code (69)
4B Service (0)
+-§ Incoming Call Route (3)
B8 WAN Port (0)
a4 Directory (0)
-7 Time Profile (D)
-8 Firewall Profile (1)
+-Jfll IP Route (7)
-l Account Code (0]
B, License (90)
i Tunnel (0)
+-§3 User Rights (8)
+g’ ARS (2)
ﬁ Location (0]
m Authorization Code (0)

| System | LANL I LANZ |DNS |Voicemai| | Telephonyl Directory Services | Systern Events

LAN Settings |VoIP | Network Topology|

IP Address 10 10 &0 52
IP Mask 255 255 255 0
Primary Trans. IP Address 0 0 0 0
Firewall Profile | <None>
RIP Mode [ None

[] Enable NAT

-

Mumber Of DHCP IP Addresses 200
DHCP Mode

) Server () Client ) Dialln @ Disabled

Advanced
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On the VoIP tab in the Details Pane, configure the following parameters:

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to

BT Wholesale.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic.

The Minimum and Maximum values were kept as default.

IP Offices

= IP500V2 Main

& BOOTP(5)
-4 Operator (3)
. IPS00V2 Main

=-
System (1)

{ Line (23]
<= Control Unit (4)
-4y Extension (48)
H-§  User (50)
- Group (1)
H-@R Short Code (69)
-4 Service (0)
oy RAS (1)
=) @ Incoming Call Route (3)
- §F) WAN Port [0)
o Directory (0)
£ Time Profile (0)

H-@ Firewall Profile (1)
-l IP Route (7)
-l Account Code (0)
B License (90)
il Tunnel (0]
H-fig User Rights (8)
=" ARS (2)

{ 50: Main

" 51t Qutbound Fax
- Location (0)
= m Authorization Code (0)

| System | LANL | LANZ |DNS |Voicemai| |Telephony| Directory Serwcesl System Events | SMTP | SMDR | VM | VolIP |VoIP Security

‘ LAN Settlngslé VoIP ;INetworkTopology|

[ H33 Gatekeeper Enable

Auto-create Extension Auto-create User

Disabled

SIP Trunks Enable

[T] SIP Registrar Enable
Auto-create Extension/User

sil.miami.avaya.com

sil.miami.avaya.com

upp 5060

TCP 5060

TLS 5061

10
RTP

Port Mumber Range
Minimum 49152 = Maximum 53246 =
Port Mumber Range (MAT)
Minimum 49152 = Maximum 53246 =

H.323 Remote Extension Enable

1720

SIP Remote Extension Enable

15060

15060

15061
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Scroll down the page:

e Inthe Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout to 30
and the Initial keepalives parameter to Enabled. These settings will cause Avaya IP
Office to send a RTP and RTCP keepalive packet starting at the time of initial connection
and every 30 seconds thereafter if no other RTP/RTCP traffic is present. This facilitates
the flow of media in cases where each end of the connection is waiting to see media from
the other, as well as helping to keep firewall ports open for the duration of the call.

e Inthe DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices | = IP500V2 Main
- R BOOTP (5) | System | LANL [ LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | veM
+-4% Operator (3) = -
=2 IPS00V2 Main | LAN Settings | VoIP [ Netwark Topelogy |
% System (1) Minimum 40152 |2 Maximum 5346 |2
- [ IPS00V2 Main
-7 Line (25)
+ - Control Unit (4) Port Mumber Range (NAT)
- Extension (48) Minirurm 43152 = Maxirmum 53246 =
w-§  User (50)
-3 Group (1) 7] Enable RTEP Monitoring on Port 5005
+-8% Short Code (69)
o B Service (1) RTCP collector IP address for phones 0 Q 0 0
oy RAS (1) i
+© Incoming Call Route (3) Keepalives
----- 8 WAN Port (0) Scope [RTP-RTCP v | Periodic timeout 20
----- @5 Directory (0)
..... £1% Time Profile (0) Initial keepalives |Enab|ed '|
=@ Firewall Profile (1)
+-Jill IP Route (7)
----- ) Account Code (D)
""" % License (90) DiffServ Settings
----- W& Tunnel (0)
1§ User Rights (8) B8 +| DSCP(Hex) B8 +| Video DSCP (Hey) FC < DSCP Mask (Hex) 88 < SIGDSCP (Hex)
= ARS (2)
- 50t Main 46 | Dsce 46 +| Video DSCP 63 < DSCP Mask 34 < s Dsce
----- && Location (0) .
----- ﬁ Authorization Code (0) DHCP Settings
Primary Site Specific Option Mumber (S50M) 176 -
Secendary Site Specific Option Number (S50N) 242 =
VLAN Mot Present -
1100 Voice VLAM Site Specific Option Mumber (SSON) 232 =
1100 Voice VLAN IDs
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between the Avaya IP Office and the BT Wholesale, the parameter was set to Open
Internet.

e Set the Binding Refresh Time (seconds) to a desired value, the value of 300 (or every 5
minutes) was used during the compliance testing. This value is used to determine the
frequency that IP Office will send OPTIONS heartbeat to the service provider.

e Set Public IP Address to the same public IP address assigned to the Avaya IP Office
WAN port.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on
which Avaya IP Office will listen, for UDP, the well-known port is 5060.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices |Ei IP500V2 Main®
:a gOOTf (5(]31 | system | Lan1 | LANZ [DNS | Voicemail | Telephony | Directory Senvices | System Events [ sMTP [ sMDR [vem [vor |
¥ g peratar
- 1P500v2 Main | LAN Settings | volp | Network Topology |
=7 System (1) .
.55 TPS00V2 Main Metwork Topology Discovery

+-T4 Line (25) STUN Server Address 69.90.168.13 STUN Port 3478

+-<2 Control Unit (4) :
+¢ Extension (48) Firewall/NAT Type |Open Internet v|
+-§  User (50) =
+ﬂ Group (1) Binding Refresh Time (sec) 300 =
8% Short Code (69) R
B Senvice (0) Public IP Address 10 10 &0 52 Run STUN Cancel
+-P Incoming Call Route (3) Public Port
88 WAN Port (0) UDP 5060 =

- h

! Time Profile (0) 0 =
- Firewall Profile (1) Tep =
+-Jill IP Route (7) TLS (i] =

Account Code (0)
» License (90) Run STUN on startup

: Tunnel (0}
+-§3 User Rights (8)
+-“f ARS (2)

Note: In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site IP network (private network). The LANL1 interface configuration is not directly
relevant to the interface with the BT Wholesale Hosted SIP Trunking Service, and therefore is
not described in these Application Notes.
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5.2.2. System - DNS Tab

To access the System DNS settings, navigate to the DNS tab in the Details Pane, configure

the following parameters:

e Under DNS Server IP Address and Backup DNS Server IP Address enter the
primary and backup public DNS servers IP addresses. These IP addresses should be
provided by BT Wholesale.

e Click OK to commit (not shown).

-5 IP500V2 Main
E| 520 System (1)

o | F-sm 1P500V2 Main
E-T4 Line (25)

B2 Control Unit (4)
(-4 Extension (48)
@ User (50)

ﬁ Group (1)

E-8X Short Code (69)
B Service (0)
-l RAS (1)

@ Incoming Call Route (3)

#

IP Offices = IP500V2 Main
a BOOTP () System | LANL | LAMNZ | DNS I‘u‘oicemail | Telephony | Directory Services | System Events
#-g Operator (3]

DMS Server IP Address g g 8 &
Backup DNS Server IP Address | 75 75 73 75
DMNS Domain
WINS Server IP Address 0 0 0 0
‘BQE;ICCILT.UEES‘.“.'TNS Server IP 0 0 0 0
WINS Scope
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5.2.3. System - Telephony Tab
To access the System Telephony settings, navigate to the Telephony - Telephony tab in
the Details Pane, configure the following parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used
for the compliance test, A-Law could have been selected instead.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be
allowed to transfer back to the PSTN then leave this setting checked.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices

IP500V2 Main

BOOTP (5)
Operator (3)

550 System (1)

IP500V2 Main

- IPS00V2 Main

o

-

@

e [

T4 Line (25)

= Control Unit (4)

-4 Extension (48)

-@  User (50)

-5 Group (1)

8% Short Code (69)

4B Service ()

-, RAS (1)

[ @ Incoming Call Route (3)

$8 WAN Port (0)

- Directory (0]
(-\ Time Profile (0}
- Firewall Profile (1)
-l 1P Route (7)

-l Account Code (0)
B License (90)

i Tunnel (07

-f4 User Rights (8)
- ARS (2)

"¢ 50: Main

----- ¥ 51: Qutbound Fax

- Location (0)
ﬁ Authorization Code (0)

| System [LANL | LAN2 | DNS | Voicemail | Telephony § Directory Services | System Events [ sMTP | SMDR [vem [ volp | volP Security

Telephony | Park&Pagel Tones&Mu;icl Ring Tone;l SM

Analogue Extensions

[ caiog [Tur |
Companding Law
Switch Line
Default Outside Call Sequence INormaI V]
Default Inside Call Sequence lRingTypel '] @ U-law @ U-Law Line
Default Ring Back Sequence lRing Typel V]
o) A-Law _) A-Law Line

Restrict Analegue Extension Ringer Voltage

Dial Delay Time (sec) 4
Dial Delay Count 0

Default Mo Answer Time (sec) 15

Al | ([<D] (ST (D] ([T {[<Te

Hold Timeout (zec) 0
Park Timeout (sec) 300
Ring Delay (sec) 5

Call Priority Promotion Time (sec) |Disabled

Default Currency usD

o

[ DSS Status
Auto Held
Dial By Mame

Show Account Code

||:| Inhibit Off-Switch Forward/Transfer

[ Restrict Netwerk Interconnect
Include location specific information
|| Drop External Only Impromptu Conference

|| Visually Differentiate External Call
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5.2.4. System - VoIP Tab

To view or change the System Codecs settings, navigate to the VolIP tab in the Details Pane as
shown in the following screen, configure the following parameters:
e The RFC2833 Default Payload field allows for the manual configuration of the payload
type used on SIP calls that are initiated by the IP Office. The default value 101 was used.
e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323)
will use the system default codec selection shown here, unless configured otherwise for a
specific line or extension. The example below shows the codecs used for IP phones (SIP
and H.323), the system’s default codecs and order was used.
e Click OK to commit (not shown).

-4 Line (25)

+ = Control Unit (4)
-4 Extension (48)
+-@  User (50)

3% Group (1)
+-93 Short Code (59)

+® Incoming Call Route (3)
48 WAN Port (0)

& Firewall Profile (1)
+-Jfll IP Route (7)
- Account Code (0)
Ry License (90)

|RFC2833 Default Payload

101

Available Codecs

Default Codec Selection
Unused

¥ G711
7] G711
7] G722 64K
7] G729(a) 8K C5-ACELP
V] 67231 6K3 MP-MLQ

G.722 64K

IP Offices = IP500V2 Main
=R BOOTP (5) | system | LaNL | LaM2 [ DNS [ Voicemail | Telephony | Directory Services | System Events | sMTP | sMDR [vem fVolP {
# Qperator (3]
P500V2 Main Ignore DTMF Mismatch For Phones
=7 Syst
.f_slg?oél\ﬂz Main Allow Direct Media Within NAT Location

Selected

R G711 ULAW 64K
G711 ALAW 64K

G.723.1 6K3 MP-MLQ

G.729(a) 8K CS-ACELP

Note: The codec selections defined under this section (System — VoIP Tab) are the codecs
selected for the IP phones/extensions. The codec selections defined under Section 5.3.7 (SIP
Line — VVoIP tab) are the codecs selected for the SIP Line (Trunk).

HG; Reviewed:
SPOC 6/7/2017

Solution & Interoperability Test Lab Application Notes

©2017 Avaya Inc. All Rights Reserved.

17 of 44
BTWSalelPO10




5.2.5. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to route calls to BT Wholesale’s network.

Navigate to IP Route, right-click on IP Route and select New. The values used during the
compliance test are shown below:
e Set the IP Address and IP Mask to 0.0.0.0 to make this the default route.
e Set Gateway IP Address to the IP Address of the gateway/router used to route calls to
the public network, e.g., 10.10.80.1.
e Set Destination to LAN2 from the pull-down menu.
e Click OK to commit (not shown).

017 Line (25)

-2 Control Unit (4)
-4 Extension (48)
@ User (50

+-5§ Group (1)
+1-@% Short Code (69)
@B Service (0)

+-alfy RAS (1)

+e Incoming Call Route (3)
----- B WAN Port (0)

----- =1 Directory (0)

----- 37 Time Profile (0)

+1-{8) Firewall Profile (1)

=} {M [P Route (7)
21110000

: 10641010
-l 10.64.70.0
il 17231210
il 192.168.128.0
[l 192.168.99.0

------ Bl 201.163.64.14

IP Offices |E
#-& BOOTP (5) IP Route
+ {7 Operator (3)
= IP500V2 Main IP Address 0 0 0 0
+ System (1) 1P Mask ) . . 5

Gateway IP Address

Destination

LANZ

Metric

Proxy ARP
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5.3. SIP Line

A SIP Line is needed to establish the SIP connection between IP Office and the BT Wholesale
Hosted SIP Trunking Service. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used
by Avaya IP Office Manager to create a SIP Line. Follow the steps in Sections 5.3.1 and 5.3.2 to
create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP trunk Registration Credentials.

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Section 5.3.3 to 5.3.8.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the
Navigation pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.4.3
t0 5.4.8.

5.3.1. Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format. These
XML templates do not include sensitive customer specific information and are therefore suitable
for distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500v2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the
Trunk, including sensitive customer specific information. Therefore, binary templates should
only be used for cloning trunks within a specific customer’s environment.

1. Copy a previously created template file to a location (e.g., C:\Temp) on the same computer
where IP Office Manager is installed. By default, the template file name will have the format
<user supplied text>.xml, where the <user supplied text> portion is entered during template
file creation.

Note — If necessary, the <user supplied text> portion of the template file name may be
modified, however the <user supplied text>.xml format of the file name must be maintained.
For example, an original template file Test.xml could be changed to Testl.xml. The template
file name is selected in Section 5.3.2, step 1, to create a new SIP Line.
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2. Import the template into IP Office Manager. From IP Office Manager, select Tools =

Import Templates in Manager.

=& BOOTP (3)
[#-¢# Operator (3)
EI'"’"T.&' O0EQOT0B530F
=429 System (1)
Ly (OEDO706

o1

File Edit View | Tools | Help
5 a E Extension Renumber...
O0ED0T06530F Line Renumber...
Connect To...
IP Ofi
Export

SCM Service User Management
Busy on Held Validation

MSM Configuration
Print Button Labels

P URI|VolP

| Import Templates in Manager

License Migration

ne

Location

A folder browser will open. Select the directory used in step 1 to store the template(s) (e.g.,

C:\Temp).

=

Browse Fo

r Folder

(S |

Select a

folder to import templates from -

. ProgramData
. SUPPORT
 swtools

) swwork

. Temnp

/ tmp
. Trilogy

) Users
1

| ok

] [ Cancel

)

In the reference configuration, template files BTWSalelPO10.xml was imported. The template
files are automatically copied into the IP Office default template location, C:\Program
Files\Avaya\lP Office\Manager\Templates.
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3. After the import is complete, a final import status pop-up window will open stating success
or failure. Click OK.

-

Template Provisioning

S

) ChTemp

5.3.2. Creating a SIP Trunk from an XML Template

o Successfully imported templates to IP Office Manager from

L

1. To create the SIP Trunk from a template, right-click on Line in the Navigation pane, and
select New from Template=>Open from file.

IP Offices

W
X
P

=R BOOTP (5)
4% Operator (3)

SIP Line |Transport |SIP URI|VelP  [T38 Fax| SIP Credentials

EI"“.H Q0EDOTOE530F line Murmher 20 =
E'!-,;_, S}rs ::J NE‘IN
EI" & Cut Ctrl+X
.33 Copy Ctrl+C
e Paste Ctrl+V ISIP
N Ctrl+Del | Cloud
. 75 Delete trl+De ou
Lwg | o/ Validate
- Co Connect To... Ctrl+T
- Ext
w§ Usil__ Newfrom Template Open from file
-9 Grd Export as Template
frnlll - 17 M)
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Navigate to C:\Program Files\Avaya\lP Office\Manager\Templates (or C:\Program Files
(x86)\Avaya\lP Office\Manager\Templates), on the bottom right hand side chose Template Files
(*.xml) format and select the template, in this case BTWSalelPO10.xml was selected.

E Open @
@Qvl i bI Computer » Avaya eS0E (C:) » Program Files (x86) » Avaya » [P Office » Manager » Templates I - |6,| ‘ Search Templates pel |
Organize * New folder =~ [ @

¥ Favorites i MName . Date modified Type Size
Bl Desktop =) BTWSzlelPO10 xrml 4/5/2017 3:07 PM XML Document 4 KB |

& Downloads

| Recent Places |-

=l Libraries
3 Documents
@' Music
[ Pictures

E Videos

M Commiter i

File name: - ITemp\ate Files (*xml) - I

l Open ] | Cancel |

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK.

I "

Temnplate Provisioning @

IOI Mew SIP Trunk created successfully using selected ternplate.

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

IP Offices

#-R BOOTP (3)

4;_...-;:1 Operator (3)

=45 O0EO0706530F
'i'"'!'"’" System (1)

—-T4 Line (3)
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It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.3.3 to 5.3.8.
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5.3.3. SIP Line = SIP Line Tab

On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below:

e Set ITSP Domain Name and Local Domain Name to siptavaya.com. The Domain
Name should be provided by BT Wholesale.

e Verify that In Service box is checked, the default value. This makes the trunk available
to incoming and outgoing calls.

e Verify that Check OOS box is checked, the default value. Avaya IP Office will use the
SIP OPTIONS method to periodically check the SIP Line. The time between SIP
OPTIONS sent by Avaya IP Office will use the Binding Refresh Time for LAN2, as
shown in Section 5.2.1.

e Verify that Refresh Method is set to Auto.

e Verify that Timer (seconds) is set to On Demand.

e For the compliance test REFER Support was disabled. Thus, Incoming Supervised
REFER and Outgoing Supervised Refer should be set to Never. Refer to Sections 2.1
and 2.2.

e Click OK to commit (not shown).

IP Offices | = SIP Line - Line 17
=R BOOTP (5) sIp L‘ﬂilTranspor‘tlslP URIlVoIP |T38 FaxlSIP Credentials | SIP Advanced |Engineering
e Oi erator |3
500V2 Main Line Number 17 = In Service |
ITSP Domain Mame siptavaya.com Check 005 v
a1 Local Domain Mame siptavaya.com
e 2 Session Timers
URI Type [sp -
M 18 ; Refresh Method Auto
w19 Location |C\Uud v|
.y, 20 Timer (sec) On Demand
21
vy, 22
y, 23 Prefix
- 201 : .
71202 Mational Prefix 1]
-4 203 . .
;- 00
1 200 International Prefix
I‘. 205 Country Code Redirect and Transfer
1 206 i
- 207 Name Priority System Default - Incoming Supervised REFER |Never
4 208 i
] Description Service Provider Outgoing Supervised REFER |Never
T4 210 Send 302 Moved Temporarily
T 211 .
1212 Outgoing Blind REFER
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5.3.4. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below:
e Setthe ITSP Proxy Address to the FQDN to be used to retrieve BT Wholesale’s Proxy
IP addresses via public DNS SRV record queries. The FQDN should be provided by BT
Wholesale. FQDN: ipcomms-btw-sipt-test-metrocore2.bt.com was used for the testing,
which resulted in the public DNS responding with two SRV records and proxy IP
addresses, one used as primary and one as secondary.

Set Layer 4 Protocol to UDP.
Set Use Network Topology Info to LANZ2, the network port used by the SIP line to

access the far-end configured in Section 5.2.1.
Set the Send Port to 5060.
Default values may be used for all other parameters.

Click OK to commit (not shown).

IP Offices

IE SIP Line - Line 17

T"'“ BOOTP (5)
+-;:‘- Operator (3
=]

* | |stP Line] Transport |sip URI|VolP | 738 Fax|SIP Credentials|SIP Advanced|Engineering

)-8 | ITSP Proxy Address  ipcomms-btw-sipt-dynamic-metrocored.br |
+*: Sistem (1)
_T" Metwork Configuration
----- a2 Layer 4 Protocol IUDP vJ Send Port 3060 =
----- y, 18 Use Network Topology Info ILAN 2 vJ 2060
..... " . 19
""" ", 20 Explicit DNS Server(s) 0 0 0 0 0 0 0 0
..... " , 21
----- "y, 22 Calls Route via Registrar
..... Wy, 23
..... T:_II 201
:::;: ;g; Separate Registrar
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5.3.5. SIP Line — SIP Credentials Tab

Select the SIP Credentials tab, and then click the Add button to add the SIP Trunk registration
credentials. Set the parameters as show below:

e For User name, add the user name credential provided by BT Wholesale for SIP Trunk
registration. This should be the pilot DDI/DID number assigned by BT Wholesale to the
SIP Trunk.

e For Authentication Name, add the authentication name credential provided by BT
Wholesale for SIP Trunk registration.

e For Contact, add the contact number credential provided by BT Wholesale for SIP Trunk
registration. This should be the same as the User Name configured above (pilot number
for the SIP Trunk).

e For Password and Confirm Password, add the password credential provided by BT
Wholesale for SIP Trunk registration.

e Set Expiry (mins) to a value acceptable to the enterprise. This setting defines how often
registration with BT Wholesale is required following any previous registration. For the
compliance test 60 minutes was used.

e Verify that Registration required is checked.

e Click the OK to commit (not shown).

IP Offices g SIP Line - Line 17*

a BOOTP (3] ar |SIP LinelTransportlSIP URIlVoIP |T38 Fax| SIP Credentials |SIp AdvancedlEngineering|

i Operator (3)

é""k"?-’ Index UserName  Authentication Mame Contact Expiration (mins] Register
rs;vﬂ]f 1 445600651234 test1234 445600651234 60 True
=T 9 Line (25)

m—]

g 18

-1 208 Edit SIP Credentials

- 200 User name 445600651234
-1 211 Authentication Mame testl234
- 212

T 213 Contact 445600651234
-7 215 Password sessnnee

B Eznztlrgl Unit (4) Cenfirm Password sssssses

[+ Extension 48] Expiration (rins) &0 :

g User (500

=-5§ Group (1) Registration required

[--@% Short Code (69)
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5.3.6. SIP Line - SIP URI Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept
on this line. Select the SIP URI tab, and then click the Add... button and the New Channel area
will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the
top, and click the Edit... button. In the example screen below, a previously configured entry was
edited. For the compliance test, a single SIP URI entry was created that matched any DDI/DID
number assigned to an IP Office user. The entry was created with the parameters shown below:

Set Local URI, Contact, Display Name to Use Internal Data.

Set Identity under Identity to Use Credentials User Name.

Set Header under Identity to P Asserted ID

Set the Originator Number under Forwarding and Twinning to the same User Name
used for SIP Trunk registration under the SIP Credentials tab (Section 5.3.5). This should
be the pilot DDI/DID number assigned by BT Wholesale to the SIP Trunk.

Set Send Caller ID under Forwarding and Twinning to None.

Set Diversion Header to None.

Select 1: xxxxxxx under Registration, Xxxxxxxxx representing the credentials used for
SIP Trunk registration under the SIP Credentials tab (Section 5.3.5).

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

Click OK to commit (not shown).

Click OK to commit again (not shown).
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IP Offices = SIP Line - Line 17° e |
& BOOTP(5)
{ Operator (3
E-5=2[IP500V2 Main URI Groups Local URI  Contact Display Name Identity Header Originator Number

=7 System (1)
EI[T{ Line (25)
o 1
L}

|SIP LmelTrans;‘.lor‘(ISIP URIlVoIP |T38 FaxlSIP Cradant\al;lSIP AdvancedlEnngering|

Send Caller D Diversion Header Credential Max Calls

Edit URI
Local URI Use Internal Data -
Contact Use Internal Data -
Display Name Use Internal Data -
Identity
Identity Use Credentials User Name -
Header P Asserted ID -

Forwarding And Twinning

Originator
Number 445600651234
Send Caller ID [NOHE -
<=2 Contrel Unit (4)
-4 Extension (48)
4 Users0)
<
a SI':ZLrItpC(;]de (69) Diversion Header Jlone] -
g ;;’;‘;S o Registration (1: 445600651234 =
g {-:;\DNmI;ro‘lg‘tC(Ua]” Route (3) Incoming Group 17 -
Directory (0] Outgoing Group 17 -
-4 1 Time Profile (0)
@ Firewall Profile (1) Max Sessions 10 =
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 28 of 44

SPOC 6/7/2017 ©2017 Avaya Inc. All Rights Reserved. BTWSalelPO10



5.3.7. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below:

e The Codec Selection was configured using the Custom option, allowing an explicit
order of codecs to be specified for the SIP Line. The buttons allow setting the specific
order of preference for the codecs to be used on the SIP Line, as shown. BT Wholesale
supports codec G.711 ALAW, G.711 ULAW, G.722 64K and G.729(a) for audio, with
G.711A being the preferred codec.

e Select G.711 for Fax Transport Support (refer to Section 2.2).

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF

tones using RTP events messages as defined in RFC2833.
Check the Re-invite Supported box.

Check the PRACK/100rel Supported box.

Default values may be used for all other parameters.
Click the OK to commit (not shown).

x—

IP Offices | = SIP Line - Line 17
- R BOOTP (5) |S[P L|ne|TranspDr‘t|SIP URIIVDIP ITES FaxlSIP Credentials | 5IP Advanced | Engineering
-7 Operator (3)
5= [IPS00V2 Main /| VolP Silence Suppression
-5 Syst
i....».i’(suej%((]l\gz Main Lecal Hold Music
S ';'jel 2 Codec Selection [Custom | % 7] Re-invite Supported
Unused Selected
Rl nuse cecte Codec Lockdown
e 17] G.72316K3 MP-MLQ o G711 ALAW B4K
-, 18 G711 ULAW 64K Allow Direct Media Path
g, 19 5.722 64K . . i
w20 .729(a) 8K C5-ACELP Force direct media with phones
wy, 21 | PRACK/100rel Supported
cce
N : ;; G.711 Fax ECAN
T4 200
T4 202
203
204 5

Fax Transport Support |GJ11 v|

DTMF Support [RFca833 -

S5 O OO VO W S O Y VO S .
s e e i e e
b
=1
=

Media Security |D\sabled v|

Note: The codec selections defined under this section (SIP Line — VoIP tab) are the codecs
selected for the SIP Line (Trunk). The codec selections defined under Section 5.2.4 (System —
VoIP tab) are the codecs selected for the IP phones/extension (H.323 and SIP).
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5.3.8. SIP Line — SIP Advanced Tab

Select the SIP Advanced tab. Set or verify the parameters as shown below:
e Verify Call Routing Method is set to Request URI.
e Check the box for Use PAI for Privacy.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

-
jax}

IP Offices = SIP Line - Line 17 ek -
R gOOTtF' (513 SIP Line| Transport|SIP URI| VolP | 738 Fax| SIP Credentials|SIP Advanced [Engineering
Addressing Media
Sysﬁ;?oél\az Main Association Method [By Source IP address =] Allow Empty INVITE B
B T |c3u Routing Method [Request uRt | - :m::p:;cﬂ:g: g
[ Suppress DNS SRV Lookups [ P-Early-Media Support
[

Send SilenceSupp=0ff

N,
g, 18
g, 19 Identity
g 20 " "
vy, 71 Use "phone-context O Media Connection Disabled -
o, 22 Add user=phone ]} Preservation
gy 23 Use + for International O Indicate HOLD =]
}j ;gé Use PAI for Privacy |
T-‘: 203 Use Domain for PAI [ Call Control
1 204 Swap From and PAI/Diversion ] Call Initistion Ti t ) 3 =
e all Initiation Timeout (<) o
T_" ig: Caller 1D from From header ]
T — . =
}_l' 07 Send From In Clear ] Call Queuing Timeout (mins) 5 =
1
17 208 Cache Auth Credentials

k Service Busy Response 486 - Busy Here
209 User-Agent and Server Headers
T4 210 9 on Mo User Responding Send | 408-Request Timeout
P ] 9
1 211

Send Location Info

=
2
@
‘.

-~ F% 212 Action on CAC Location Limit | Allow Yoicemail
S RE]
Ti‘. 74 I5_{|.|:;[:ldr:rss .850 Reason B
E = Emulate NOTIFY for REFER ]
=+ Control Unit (4) Mo REFER. if using Diversion =
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5.4. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.3. To configure these settings, first navigate to User - Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is H323 ext 1502. Select the SIP tab in the Details Pane. The values entered for
the SIP Name allow matching of the SIP URI for incoming calls without having to enter this
number as an explicit SIP URI for the SIP line (Section 5.3.6). The SIP Name and Contact are
set to one of the DDI/DID numbers assigned to the enterprise by BT Wholesale. The SIP
Display Name (Alias) parameter can optionally be configured with a descriptive name. Click the
OK to commit (not shown).

IP Offices |Ei H323 ext 1502: 1502°
----- 1115 Extnl115 - - - - - - - -
_____ 1116 Extri 116 | Dial In | Voice Recording | Button Programming | Menu Pregramming | Mobility | Group Membership | Announcementsl sIP |
""" 1503 Extn1503analog SIP Name 445600651234
----- 1504 Extn1504
----- 1505 Extnl1505 SIP Display Name (Alias) H323 ext 1502
----- 1506 Extn1506
----- 1507 Extnl507 Contact 445600651234
----- 1508 Extn1508
----- 1509 Extn1509
----- 1510 Extn1510 Anonymous
----- 1596 Extn1596
----- 1597 Extn1597
----- 1598 Extn1598
----- 1599 Extn1539
----- 1600 Extn1600
----- 1601 Extn1601
----- 1602 Extn1602
----- 1603 Extnl1603
-----
----- 1542 H323 ext 1542
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5.5. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.5.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation Pane
and select New. The screen below shows the short code 9N created (note that the semi-colon is
not used here). In this case, when the Avaya IP Office user dials 9 plus any number N, instead of
being directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which
is configurable via ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group Id to 50: Main to be directed to Line Group 50: Main, this is
configurable via ARS.
e For Locale United States (US English) was used.
e Click the OK to commit (not shown).

IP Offices = 9N: Dial
----- B =45 NE + || Short Code
----- PX 46
----- ™ 47 Code oM
----- P *43
..... X 49 Feature Dial
----- 2X *50
_____ Bx ~51 Telephone Mumber M
----- X 52 : YR
_____ O 53NE Line Group ID 50: Main
""" @55 Locale United States (US English)
----- BX *57*NE
..... BX B0 Force Account Code
""" Px *ﬁl*N’_{ Force Authorization Code
----- BX *T0* N2
..... “ EN
§ EE1SN
----- 83 _FNEOD
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The following screen shows the example ARS configuration for the Line Group Id to 50: Main.
Note the sequence of X’s used in the Code column of the entries to specify the exact number of
digits to be expected, following the access code and the first set of digits on the string. This type
of setting results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation Pane and
click Add.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 056
followed by 8 X’s to represent the exact number of digits after the 6.
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to 056N. The value N represents the additional number of digits
dialed by the user after dialing 056 (The 9 will be stripped off).
e Setthe Line Group Id to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.
e Click OK to commit.

| Edit Short Code
Code DBEXCOOGO0X
Featurs Dial -
Telephone Mumber 056N lﬂl
Line Group |D 17 -
Locale -
Faorce Accourt Code
Force Authorization Code

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.
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The highlighted items below shows a subset of dial patterns used during the compliance test, the
user dialed 9, followed by 012 or 056 and 8 digits (represented by 8 X’s). In each case the 9 is
stripped off, the remaining digits, including the 012 or 056 shown in the examples below, are
included in the SIP INVITE message IP Office sends to BT Wholesale.

IP Offices |E Main

R BoOTP (5) ARS

Fi-4%_Operator (3

& ARS Route ID 50 Secondary Dial tone

=~ System (1)

- L";EIFSE?W Main Route Name Main [SystemTone b

= Control Unit (4)

A48 Extension (48) Dial Delay Time System Default (4) = Check User Call Barring

% User (50)

-~k Group (1) L

-9 Short Cods (69) Description

B Service (0)

ally RAS (1)

@ Incoming Call Route (3) In Service Qut of Service Route [<Nona> -

9 WAN Port (0) 1
- Directory (0)

£ Time Profile (0) Time Profile <None> e} Out of Hours Route [<NOHE> b
- Firewall Profile (1)

-l IP Route (7) l
-~ Account Code (0)

; _Lri(ansle ((?0) Code Telephone Number Feature Line Group ID o Add...
B Vo pfi(his @ 809:000000¢ 809N Dial 17
3. 28XHKKKK 28N Dial 17 T
006XXHKHK 006N Dial 17 -
- : LEEOU”d Fax [orzxaecoe 012N Dial 17| Edit..
ocation
%% Authorization Code (0) ks 326N D!EI 1 =
[osex0aooa 056N Dial 17] 5
4 n (2
3 l
30 | ——— Alternate Route <MNone> -
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5.6. Incoming Call Route

An incoming call route maps inbound DDI/DID numbers on a specific line to internal
extensions, hunt groups, short codes, etc., within the IP Office system.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters previously configured for
Call Routing Method and SIP URI (Section 5.3.6) and the users SIP Name and Contact,
already populated with the assigned BT Wholesale DDI/DID numbers (Section 5.4).

5.6.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details pane, enter the parameters as shown below:

e Set Bearer Capacity to Any Voice.

e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.3, in
this case Line Group ID 17 was used.

e Default values can be used for all other fields.

Ll

IP Offices = 17
1R BOOTP (5) Standard | Voice Recording | Destinations |
-4 Operator (3
=)-={ IP500V2 Main
+)-%53 System (1) Bearer Capabili Any Voice T
-7 Line (26) penity I -
1] Control Unit (4) Line Group ID 17 -
+-4 Extension (48)
+i User (50) Incoming Mumber
+;a Group (1)
+-@% Short Code (59) Incoming Sub Address
4 Service (0) :
+“% RAS (1) Inceming CLI
% Inceming Call Route (3] Locale I v]
. Priority 1-Low T
..... e 0 I I
----- B8 WAN Port (0) Tag
----- as Directory (0]
..... {,“- Time Profile (0) Hold Music Source IS],rstem Source ‘I
+-{14t Firewall Profile
+g 1P Route (7) S Ring Tone Override Mone -
----- @8 Account Code (0)
----- 8 License (90)
----- % Tunnel (0)
1§43 User Rights (8)
- ARS (2)
E Location (0]
ﬂ Authorization Code (0]
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5.6.2. Incoming Call Route — Destinations Tab

Under the Destinations tab, enter “.” for the Default VValue. This setting will allow the call to be
routed to any destination with a value on its SIP Name field, entered on the SIP tab of the User,
which matches the number present on the user part of the “To” header on the incoming INVITE

message received from BT Wholesale. Click OK to commit (not shown).

IP Offices

| F

17

=& BOOTP (3)

T
i+ Control Unit (4)
a4 Extension (48)
w-§  User (50)

-3 Group (1)
&8 Short Code (69
@ Service (0)

-l RAS
—e Incoming Call Route (3)
P
-0

L™
-4} WAN Port (0

@ Directory (0)

-1 Tirme Profile (0)

+@ Firewall Profile (1)
-l 1P Route (7)

-l Account Code (D)
B License (90)

-l Tunnel (0)

3 ﬁ 3 User Rights (8)

- ARS (2)

E Location (0)

ﬂ Authorization Code (0)

| Standard |Voir_e Recording | Destinations

4

TirmeProfile Destination

Fallback Extension

Default Value

|v||
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5.7. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

HG; Reviewed:
SPOC 6/7/2017

e

Save Configuration

IP Office Settings
IP500V2 Main

Configuration Reboot Mode
Merge

@ Immediate
When Free
Tirmed

Reboot Time

11:31

Call Barring

fol® &)

Ok l | Cancel | |

Help
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6. BT Wholesale Hosted SIP Trunking Services Configuration

To use BT Wholesale’s Hosted SIP Trunking service, a customer must request the service from
BT Wholesale using the established sales processes. The process can be started by contacting BT
Wholesale via the corporate web site at: https://www.btwholesale.com/pages/static/home.htm
and requesting information.

During the signup process, BT Wholesale and the customer will discuss details about the
preferred method to be used to connect the customer’s enterprise network to BT Wholesale’s
network.

BT Wholesale is responsible for the configuration of BT Wholesale Hosted SIP Services. The
customer will need to provide the public IP address used to reach the Avaya IP Office at the
enterprise. In the case of the compliance test, this is the public IP address of the Avaya IP Office
WAN port (LAN2). The customer will also need the IP addresses for the primary and the
secondary public DNS servers, these addresses can be obtained from BT Wholesale.

BT Wholesale will provide the customer the necessary information to configure Avaya IP Office
following the steps discussed in the previous sections, including:

e FQDN to be use for public DNS SRV record queries.

e Domain name.

e SIP Trunk registration credentials (User Name, Password, etc.).

e DDI/DID numbers and the number to be use as the pilot number.
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7. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
e Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
e Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

7.1. IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections.

Launch the application from Start - Programs - IP Office - System Status on the PC
where IP Office Manager is installed, log in with the proper credentials.

AVAyA IP Office System Status

Help Exit About

Online | offline

Logon

Control Unit IP Address: EloEERriR -

Local IP Address: [ T IR

[ Auto reconnect

[l secure connection Logon
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

tus  Utilization Summary Alarms  Registration
SIP Trunk Summary

Line Service State: In Service
Peer Domain Name: siptavaya.com
Resolved Address: .105
Line Mumber: 17
MNumber of Administered Channels: 10
Mumber of Channels in Use: 0
Administered Compression: G711 A, G711 Mu, G722, G729 A
Enable Faststart: Off
Silence Suppression: on
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: 128 . T
SIP Trunk Channel Licenses in Use: 0

SIP Device Features:

URI CallRef CurrentState Timein State Remote Media Codec  Connection Caller ID o Other Party on Call Direction

r Gr. ! Ty Dialed Digits Call
1 Idle 01:51:26
2 Idle 06:33:43
3 Idle 22:26:47
4 Idle 22:26:47
5 Idle 22:26:47
6 Idle 22:26:47
7 Idle 22:26:47
8 Idle 22:26:47
9 Idle 22:26:47
10 Idle 22:26:47
Trace Trace Al ] [ Pause ] [ Ping ] Call Details Graceful Shutdown ] [ Force Out of Service ] [ Print... ] [ Save As...
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Select the Alarms tab and verify that no alarms are active on the SIP line.

-5 Avaya IP Office System Status - IPS00V2 Main (10.64.70.60) - IPS00 V2 10.0.0.20 build 10 _ [E=REEE )
AVAyA IP Office System Status

Status  Utilization Summary Alarms Registration

Alarms for Line: 17 SIP clearcom.mx

Last Date Of Error Ocrurrences Error Description

Clear Clear All Graceful Shutdown ] [ Force Out of Service Print...

1:12:25 PM Online

IP Office System Status

Status  Utlization Summary Alarms | Registration
Registration Status
1 44550065 Registered 4/7[2017 1:43:26 PM
[ Pause ][ Ping ][ Graceful Shutdown ][ Force Out of Service
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Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs - IP Office >
Monitor on the PC where Avaya IP Office Manager was installed. Click the Select Unit icon on
the taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]
File Edit Wiew Fikers Status Help

=& »8T| x|V @ ==

' RN

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings =3
T1 | woomp | wPN | weN | soN | ssl | Jade |
aTM | Cal | DTE | ECont | FrameRelaw | GOD | H323 | Interface |
15SDM | Few/Lamp | Directon | Media | PFP | R2 | Routing | Services SIF |S_l,lstem|
Ewvents
¥ Sip [Vobose - I STUM [~ SIP Dect
Packetz
[~ SIP Reg/Opt R= [~ SIP Misc B=
[~ SIP Reg/Opt Tx [ SIP Misc Tx
[ SIPCallRx [~ Crn Motifp R«
[~ SIPCallTx [~ Crn Motify T=
I+ Sip Rx I hex IP Filter [nan.nnn.nnn. nnn)
¥ Sip Tx ™ hex |
Default AII| Clear All | Tab C|eam||| Tab sBmu| 86 ]| cancel
Save | Load File | Load Partial File| Select File |
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8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office
Release 10.0 to BT Wholesale Hosted SIP Trunking Services. BT Wholesale Hosted SIP
Trunking Services is a SIP-based Voice over IP solution for customers ranging from small
businesses to large enterprises. It provides a flexible, cost-saving alternative to traditional
hardwired telephony trunks.

Interoperability testing was completed successfully with the observations/limitations outlined in
the scope of testing in Section 2.1 as well as under test results in Section 2.2.

9. Additional References

This section references the documentation relevant to these Application Notes. Product
documentation for Avaya IP Office, including the following, is available at:
http://support.avaya.com/

[1] Avaya IP Office Platform Solution Description, Release 10.0, August 2016.
[2] Avaya IP Office Platform Feature Description, Release 10.0, August 2016.
[3] Deploying Avaya IP Office Platform IP500 V2, Document Number 15-601042, Issue 31q,
February 06, 2017.
[4] Administering Avaya IP Office Platform with Manager, Release 10.0, September 2016.
[5] IP Office Platform 10.0 Using Avaya IP Office Platform System Status, Document 15-
601758, Issue 11f, February 06,, 2017.
[6] IP Office Platform 10.0 Using IP Office System Monitor, Document 15-601019, Issue 08b,
November 25, 2016.
[7] Using Avaya Communicator for Windows on IP Office, Release 10, August 2016.
[8] Administering Avaya Communicator on IP Office, Release 10.0, Issue 01.01, August 2016
[9] IP Office Platform 10.0 Installing and Maintaining the Avaya IP Office Platform Application
Server, Document 15-601011, Issue 11j, January 31, 2017.
[10] Avaya Communicator for Web-1P Office Platform, User Guide, Release 1.0, Issue 1.0.11,
October 2016.
[11] Avaya Communicator for Web-IP Office Platform, Administration Guide, Release 1.0, Issue
1.0.16, January 2017.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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